
  

Gi i thi u chungớ ệ
Microsoft Word là ch ng trình x  lý văn b n cao c p ươ ử ả ấ
trên n n h  đi u hành Windows chuyên dùng so n ề ệ ề ạ
th o các lo i vả ạ ăn b nả , sách v , t p chí,…ở ạ
Ch c năng:ứ
          Nh p và l u tr  văn b nậ ư ữ ả
          S a đ i văn b nử ổ ả
          Trình bày văn b nả
                   Đ nh d ng kí tị ạ ự
                    Đ nh d ng đo n văn b n ị ạ ạ ả
                    Đ nh d ng trang văn b nị ạ ả
             M t s  ch c năng nâng cao khácộ ố ứ
                       Ki m tra chính t , gõ t tể ả ắ
                       Tr n th …ộ ư
                       Giao ti p d  li u v i các ng d ng khác, ế ữ ệ ớ ứ ụ
h  tr  nhi u lo i đ nh d ng                                              ỗ ợ ề ạ ị ạ
                văn b n…ả



  

Kh i đ ng và thoát kh i Wordở ộ ỏ
• Kh i đ ng Wordở ộ

– Cách 1: 
-> Start 

-> (All) Programs 
-> Microsoft Office 
-> Microsoft 
Office Word 2003

– Cách 2: 
Nháy đúp 

bi u t ng Word ể ượ
trên màn hình n nề

Cách 3: Gõ Winword trong h p Runộ



  

Kh i đ ng và thoát kh i Wordở ộ ỏ
• Thoát kh i Wordỏ

– Cách 1:  ->         (Close Window)
– Cách 2:  -> File -> Exit
– Cách 3:  Nh n t  h p phím Alt + F4ấ ổ ợ

N u tài li u ch a đ c ghi l u thì MS-Word s  hi n th  h p tho i ế ệ ư ượ ư ẽ ể ị ộ ạ
nh c nh  ghi l u tài li u.ắ ở ư ệ

Nh n ấ Yes: L u và thoát kh i Wordư ỏ
    No  : Không l u và thoát kh i Wordư ỏ
    Cancel: H y b  l nh đóngủ ỏ ệ



  

Gioi thieu man hinh word

Menu bar   
Title bar    

Standard 
Toolbar 

Formatting 
Toolbar Ruler

Thanh công c  ụ
( Drawing)Thanh tr ng tháiạ

Thanh cu n ộ
màn hình

VÙNG SO N TH O VĂN B NẠ Ả Ả



  

• Ta th c hi n theo các b c sau:ự ệ ướTa th c hi n theo các b c sau:ự ệ ướ
• - Ch n l nh ọ ệ- Ch n l nh ọ ệ File/SaveFile/Save (Ho c nh n ặ ấ (Ho c nh n ặ ấ Ctrl-SCtrl-S, ,  ))
• - Ch n  đĩa, th  m c ch a t p tin c n l uọ ổ ư ụ ứ ậ ầ ư- Ch n  đĩa, th  m c ch a t p tin c n l uọ ổ ư ụ ứ ậ ầ ư
• - Gõ tên t p tin vào h p ậ ộ- Gõ tên t p tin vào h p ậ ộ File nameFile name
• - Nh n nút ấ- Nh n nút ấ ToolsTools đ  đ t các tùy ch n và nh n nút ể ặ ọ ấ đ  đ t các tùy ch n và nh n nút ể ặ ọ ấ

OKOK
• - Nh n nút ấ- Nh n nút ấ SaveSave đ  l u.ể ư đ  l u.ể ư

Làm th  nào đ  l u m t tài li u ế ể ư ộ ệLàm th  nào đ  l u m t tài li u ế ể ư ộ ệ
lên đĩa?lên đĩa? 

L u file v i tên khác:ư ớ
        Cách 1: Vào File \ Save as... 
        Cách 2: Nh n phím ấ F12
        → Ch n  đĩa (ho c th  m c) ch a file c n l u  ô ọ ổ ặ ư ụ ứ ầ ư ở
Save in
        → Nh p tên m i c n đ t  ô ậ ớ ầ ặ ở File name
        → Ch n ọ Save



  

Làm th  nào m  m t tài li u m i ế ở ộ ệ ớLàm th  nào m  m t tài li u m i ế ở ộ ệ ớ
đ  so n th o? ể ạ ảđ  so n th o? ể ạ ả

•       Ch n m t trong các cách sauọ ộCh n m t trong các cách sauọ ộ ::
• - Ch n l nh ọ ệ- Ch n l nh ọ ệ File/NewFile/New
• - Nh n phím ấ- Nh n phím ấ Ctrl-NCtrl-N
• - Nh p chu t trên bi u t ng ấ ộ ể ượ- Nh p chu t trên bi u t ng ấ ộ ể ượ NewNew c a thanh công ủ c a thanh công ủ

c . ục . ụ

Làm th  nào đ  m  m t tài li u ế ể ở ộ ệLàm th  nào đ  m  m t tài li u ế ể ở ộ ệ
đang có trên đĩa?đang có trên đĩa? 

Ta th c hi n theo các b c sau:ự ệ ướTa th c hi n theo các b c sau:ự ệ ướ
- Ch n l nh ọ ệ- Ch n l nh ọ ệ File/OpenFile/Open (Ho c nh n phím ặ ấ (Ho c nh n phím ặ ấ Ctrl – OCtrl – O, , ))
- Ch n  đĩa, th  m c ch a t p tin c n mọ ổ ư ụ ứ ậ ầ ở- Ch n  đĩa, th  m c ch a t p tin c n mọ ổ ư ụ ứ ậ ầ ở
- Ch n ho c gõ tên t p tin c n m  vào ô ọ ặ ậ ầ ở- Ch n ho c gõ tên t p tin c n m  vào ô ọ ặ ậ ầ ở File nameFile name
- Nh n nút ấ- Nh n nút ấ OpenOpen..



  

Mo mot tai lieu da co tren dia

Ch n  đĩaọ ổ

Ch n file ho c ọ ặ
th  m c ch a ư ụ ứ

file c n mầ ở



  

T o tài li u m iạ ệ ớ
• M c đ nh, khi kh i đ ng, Word t  đ ng t o m t ặ ị ở ộ ự ộ ạ ộ

tài li u có tên ệ Document1
• Cách 1: Ch n menu ọ File -> New, r i ch n ồ ọ Blank 

document  khung công vi c bên ph iở ệ ả

• Cách 2: Nh n nút ấ New      trên thanh công c  ụ
Standard

• Cách 3: Nh n t  h p phím t t Ctrl + Nấ ổ ợ ắ
Word s  t  đ ng t o m t tài li u m i có tên ẽ ự ộ ạ ộ ệ ớ

d ng DocumentX (X tăng d n)ạ ầ



  

S  d ng các thanh công cử ụ ụ

• Thanh công c  Standardụ

• Thanh công c  Formattingụ

• Thanh công c  Drawingụ

• Đ  n/hi n thanh công c :ể ẩ ệ ụ
– Ch n View -> Toolbars r i nháy ch n thanh công cọ ồ ọ ụ
– Nháy ph i lên vùng tr ng trên thanh công c  r i ch nả ố ụ ồ ọ
Di chuy n thanh công c :ể ụ   Nh n      và kéo thấ ả

• Di chuy n chu t lên nút b m đ  bi t tên nútể ộ ấ ể ế



  

Làm th  nào đ  đóng m t tài li u ế ể ộ ệLàm th  nào đ  đóng m t tài li u ế ể ộ ệ
đang m ? ởđang m ? ở

• Ta th c hi n theo các b c sau:ự ệ ướTa th c hi n theo các b c sau:ự ệ ướ
• -    Ch n c a s  tài li u ch a t p tin c n đóngọ ử ổ ệ ứ ậ ầ-    Ch n c a s  tài li u ch a t p tin c n đóngọ ử ổ ệ ứ ậ ầ
• -    Ch n l nh ọ ệ-    Ch n l nh ọ ệ File/CloseFile/Close, ho c nh n nút ặ ấ, ho c nh n nút ặ ấ Close.Close.

Chú ý: Khi đóng file, n u ch a đ c l u l n cu i s  có ế ư ượ ư ầ ố ẽ
thông báo sau:

L uư Không l uư Đóng c a sử ổ



  

Nhap va hieu chinh van ban

Các phím nào th ng dùng trong nh p văn ườ ậCác phím nào th ng dùng trong nh p văn ườ ậ
b n? ảb n? ả

• +  +  //: Sang ph i/trái m t ký tả ộ ự: Sang ph i/trái m t ký tả ộ ự
• +  +  //: Lên xu ng m t dòngố ộ: Lên xu ng m t dòngố ộ
• + + HomeHome//EndEnd: V  đ u, cu i dòngề ầ ố: V  đ u, cu i dòngề ầ ố
• +  +  DeleteDelete: Xóa m t ký t  bên ph i con trộ ự ả ỏ: Xóa m t ký t  bên ph i con trộ ự ả ỏ
• +  +  BackspaceBackspace: Xóa m t ký t  bên trái con trộ ự ỏ: Xóa m t ký t  bên trái con trộ ự ỏ
• +  +  CaplockCaplock: B t/t t ch  đ  gõ ch  hoaậ ắ ế ộ ữ: B t/t t ch  đ  gõ ch  hoaậ ắ ế ộ ữ
• +  +  ShiftShift: Thay đ i cách gõ c a m t phímổ ủ ộ: Thay đ i cách gõ c a m t phímổ ủ ộ
• +  +  EnterEnter: Xu ng dòng và qua m t đo n m i.ố ộ ạ ớ: Xu ng dòng và qua m t đo n m i.ố ộ ạ ớ



  

Có nh ng thao tác ch n văn b n nào? ữ ọ ảCó nh ng thao tác ch n văn b n nào? ữ ọ ả

• - - Ch n m t ký tọ ộ ựCh n m t ký tọ ộ ự: Quét chu t trên ký t  c n ch n.ộ ự ầ ọ: Quét chu t trên ký t  c n ch n.ộ ự ầ ọ
• - - Ch n m t tọ ộ ừCh n m t tọ ộ ừ: Nh p đúp chu t trên t .ấ ộ ừ: Nh p đúp chu t trên t .ấ ộ ừ
• - - Ch n m t câuọ ộCh n m t câuọ ộ : Nh n Ctrl và nh p chu t trên câu.ấ ấ ộ: Nh n Ctrl và nh p chu t trên câu.ấ ấ ộ
• - - Ch n m t đo nọ ộ ạCh n m t đo nọ ộ ạ : Nh p chu t 3 l n liên ti p trên đo n ấ ộ ầ ế ạ: Nh p chu t 3 l n liên ti p trên đo n ấ ộ ầ ế ạ

mu n ch n.ố ọmu n ch n.ố ọ
• - - Ch n toàn b  văn b nọ ộ ảCh n toàn b  văn b nọ ộ ả : nh n Ctrl-A ho c ch n l nh ấ ặ ọ ệ: nh n Ctrl-A ho c ch n l nh ấ ặ ọ ệ

Edit/Select All.Edit/Select All.
• - - Ch n m t kh i b t kỳọ ộ ố ấCh n m t kh i b t kỳọ ộ ố ấ : Kéo chu t t  đ u kh i đ n cu i ộ ừ ầ ố ế ố: Kéo chu t t  đ u kh i đ n cu i ộ ừ ầ ố ế ố

kh i.ốkh i.ố

Làm th  nào đ  xóa văn b n?ế ể ảLàm th  nào đ  xóa văn b n?ế ể ả  
- Ch n kh i văn b n c n xóaọ ố ả ầ- Ch n kh i văn b n c n xóaọ ố ả ầ
- Ch n l nh ọ ệ- Ch n l nh ọ ệ Edit/ClearEdit/Clear (ho c nh n phím ặ ấ (ho c nh n phím ặ ấ DeleteDelete))
- - L u ýưL u ýư : Khi m t kh i văn b n đang đ c ch n n u ta ộ ố ả ượ ọ ế: Khi m t kh i văn b n đang đ c ch n n u ta ộ ố ả ượ ọ ế
ch m vào m t phím ký t  thì kh i văn b n s  b  xóa.ạ ộ ự ố ả ẽ ịch m vào m t phím ký t  thì kh i văn b n s  b  xóa.ạ ộ ự ố ả ẽ ị



  

S  d ng ch c năng Undo/Redoử ụ ứ
• Ch c năng ứ Undo MS-Word cho phép thao tác Undo 

nhi u l n đ  tr  l i m t tr ng thái cũ đã qua nhi u b c ề ầ ể ả ạ ộ ạ ề ướ
th c hi n.ự ệ

• Ch c năng ứ Redo, cho phép tr  l i tr ng thái đã có tr c ả ạ ạ ướ
đó khi th c hi n ự ệ Undo.

Di chuy n vể ăn b nả
Cách 1: 
Ch n kh i văn b n c n chuy nọ ố ả ầ ể
C t văn b n ắ ả

Edit Cut
Nh n nút Cut  trên thanh công c  Standardấ ụ
Nh n Ctrl +Xấ

Di chuy n con tr  t i v  trí m iể ỏ ớ ị ớ
Dán văn b n (Paste)ả

M  m c ch n Edit ở ụ ọ  Paste
Nh n nút Paste  trên thanh công c  Standardấ ụ
Nh n t  h p phím nóng Ctrl + Vấ ổ ợ



  

Cách 2:
• Ch n kh i văn b n c n chuy nọ ố ả ầ ể
• Kéo rê vùng văn b n đang ch n th  lên v  trí c n di ả ọ ả ị ầ

chuy n đ nể ế

Xoá văn b nả
B c 1:ướ  Ch n văn b n.ọ ả
B c 2:ướ  Nh n phím ấ Delete ho c m  ch n ặ ở ọ
Edit   Clear   Contents
Ctrl+Delete: xóa m t t  bên ph i con tr  nh pộ ừ ả ỏ ậ
Ctrl+Backspace: xóa m t t  bên trái con tr  ộ ừ ỏ
nh pậ



  

Sao chép văn b nả
Cách 1:
• B c 1: ướ Ch n vọ ăn b nả  c n sao chépầ
• B c 2:ướ  Sao chép d  li uữ ệ

– Cách 1: Edit   Copy
– Cách 2: Nh n nút Copy  trên thanh công c  Standardấ ụ
– Cách 3: Nh n Ctrl + Cấ

• B c 3:  ướ Đ t con tr  vào v  trí c n dán văn b nặ ỏ ị ầ ả
• B c 4: ướ Dán văn b n:ả

– Cách 1: M  m c ch n Edit ở ụ ọ  Paste
– Cách 2: Nh n nút Paste  trên thanh công c  ấ ụ

Standard
– Cách 3: Nh n t  h p phím nóng Ctrl + Vấ ổ ợ

Cách 2: Nh n gi  Ctrl và kéo rê đo n vấ ữ ạ ăn b nả  c n ầ
sao chép đ n v  trí c n thi tế ị ầ ế



  

 Chèn kí t /kí hi u đ c bi tự ệ ặ ệ

• Đ t con tr  nh p t i v  trí c n chèn.ặ ỏ ậ ạ ị ầ
• Ch n ọ Insert -> Symbol
• Trong h p tho i ộ ạ Symboys, ch n Symboys, ch n Font ọ ọ

ch , nháy chu t vào kí t  c n chèn, nh n nút ữ ộ ự ầ ấ Insert

- Có th  đ t phím ể ặ
t t cho các kí hi u ắ ệ
b ng nút ằ Shorrtcut 
key…
- M c ụ Special 
Characters ch a ứ
các kí hi u đ c bi t ệ ặ ệ
nh  ©, ®, …ư



  

 Đ nh d ng kí tị ạ ự
• B c 1ướ : Ch n vọ ăn b nả  c n đ nh d ngầ ị ạ
• B c 2ướ : Format  Font… (ho c Ctrl + D)ặ

Font chữ

Màu chữ

Chỉ số trên

Chỉ số dưới

Thiết đặt 
ngầm định

Kiểu chữ

Cỡ chữ

Màu gạch chân

Gạch chân

Xem trước kết 
quả

Áp dụng



  

Đ nh d ng kí tị ạ ự

• S  d ng thanh công c  ử ụ ụ Formatting

• Đ  thay đ i c  ch , có th  dùng phím t t ể ổ ỡ ữ ể ắ
– Ctrl + [  : gi m c  ch  xu ng 1 đ n vả ỡ ữ ố ơ ị
– Ctrl + ]  : tăng c  ch  lên 1 đ n vỡ ữ ơ ị

Chọn kiểu Cỡ chữ In nghiêng

Font chữ In đậm Gạch chân



  

dieu chinh khoang cach giua cac ki tu

Tỉ lệ co dãn 
bề ngang của 
kí tự

Khoảng cách 
giữa các kí tự

Giảm khoảng cách 
không cần thiết 
giữa một số cặp kí 
tự

Định vị của kí 
tự so với 
đường kẻ

Quan sát trước



  

Đ nh d ng đo n vị ạ ạ ăn b nả

Căn lề

Vị trí lề trái

Khoảng cách 
giữa các dòng

Định dạng dòng 
đầu tiên

Khoảng cách 
giữa các đoạn 
văn

Vị trí lề phải



  

Cách 2: S  d ng thanh công c  Formattingử ụ ụ

Căn lề trái Căn lề phải Khoảng cách 
giữa các dòng

Giảm lề một 
khoảng

Căn lề giữa Căn lề đều 2 bên
Tăng lề một 
khoảng

 Đ nh d ng l :ị ạ ề
    - Ch n đo n văn b n c n đ nh d ngọ ạ ả ầ ị ạ
    - S  d ng các nút trên thanh th c ngang:ử ụ ướ

L  đ u dòng c a đo nề ầ ủ ạ

L  trái c a đo nề ủ ạ

L  t  dòng th  2 tr  đi c a đo nề ừ ứ ở ủ ạ

L  ph i c a đo nề ả ủ ạ



  

Bullets and Numbering

Ký t  đ u dòng:ự ầ
• - Ch n đo n văn b n c n đ nh d ngọ ạ ả ầ ị ạ
•         - Th c hi n 1 trong 2 cách:ự ệ
•           Cách 1: Ch n bi u t ng       ọ ể ượ (Bullets) trên thanh 

công c  ụ Formatting
•           Cách 2: Vào Format \ Bullets and Numbering...
•       → Ch n ọ Bulleted
•       → Ch n ki u c n đ nh d ng → ọ ể ầ ị ạ OK
•           Chú ý: Mu n ch n ký t  khác ta vào ố ọ ự

Customize... 
• → Ch n ọ Character... 
• → Trong m c ụ Font ta ch n ki u font (ọ ể Symbol, 

Wingdings)
• → Ch n ký t   → ọ ự OK



  



  

S  đ u dòng:ố ầ
• Ch n đo n văn b n c n đ nh d ngọ ạ ả ầ ị ạ
•         - Th c hi n 1 trong 2 cách:ự ệ
•           Cách 1: Ch n bi u t ng         ọ ể ượ (Numbering) trên 

thanh công c  ụ Formatting
•           Cách 2: Vào Format \ Bullets and Numbering...
•       → Ch n ọ Numbered
•       → Ch n ki u c n đ nh d ng → ọ ể ầ ị ạ OK
•           Chú ý: M cụ  Restart numbering :   B t đ u ắ ầ

l i t  1ạ ừ
•         Continue previous list : Ti p vào s  ế ố

tr cướ
•         Customize... :   Đ nh d ng l iị ạ ạ
• Có th  s  d ng bi u t ng                đ  đi u ch nh ể ử ụ ể ượ ể ề ỉ

l  tráiề



  



  

Tab
• C1: Đ t d u Tab thông th ngặ ấ ườ

- Xác đ nh và ch n các đo n văn b n liên ti p có cùng ị ọ ạ ả ế
nhóm c n đ nh d ng.ầ ị ạ
        - L n l t ch n lo i đi m d ng và đ t lên th cầ ượ ọ ạ ể ừ ặ ướ

        - L n l t đ t con tr  văn b n vào đ u các đo n → ầ ượ ặ ỏ ả ầ ạ
Nh n phím ấ Tab
        - Ch n l i đo n văn b n trên → Hi u ch nh (n u ọ ạ ạ ả ệ ỉ ế
c n)ầ



  

C2: Đ t d u Tab có kèm thêm kí hi u phía tr cặ ấ ệ ướ

- Vào Format \ Tabs... 

        - L n l t th c hi n các công vi c sau:ầ ượ ự ệ ệ
          + Trong m c ụ Tab stop position ta ch n đi m d ngọ ể ừ
          + Trong m c ụ Leader ta ch n ki u đ ng đ nh d ngọ ể ườ ị ạ
          + Ch n ọ Set thi t l p Tabế ậ OK

Ch n đi m d ngọ ể ừ

Ki u căn lể ề

Ch n ki u đ ngọ ể ườ

Thi t l pế ậ

Đi m d ng m c ể ừ ặ
đ nh khi nh n ị ấ

phím Tab không 
có đ nh d ngị ạ



  

Đ nh d ng Khung, N nị ạ ề

•  Đ nh d ng khungị ạ
Ch n văn b nọ ả

 Format  Border and Shading  Borders

Các nút k  ẻ
t ng đ ng ừ ườ

khung

Ki u đ ng kể ườ ẻ

Màu đ ng kườ ẻ Đ  dày đ ng ộ ườ
kẻ

Không k  ẻ
khung

Ch  k  khung ỉ ẻ
biên ngoài

K  khung bao ẻ
quanh t t c  ôấ ả

T  k  khung ự ẻ
theo ý mu nố

Khung xem 
tr cướ



  

Đ nh d ng n nị ạ ề



  



  


	Giới thiệu chung
	Khởi động và thoát khỏi Word
	Slide 3
	Gioi thieu man hinh word
	Làm thế nào để lưu một tài liệu lên đĩa? 
	Làm thế nào mở một tài liệu mới để soạn thảo?  
	Mo mot tai lieu da co tren dia
	Slide 8
	Sử dụng các thanh công cụ
	Làm thế nào để đóng một tài liệu đang mở?  
	Nhap va hieu chinh van ban
	Có những thao tác chọn văn bản nào?  
	Sử dụng chức năng Undo/Redo
	Slide 14
	Sao chép văn bản
	 Chèn kí tự/kí hiệu đặc biệt
	 Định dạng kí tự
	Định dạng kí tự
	dieu chinh khoang cach giua cac ki tu
	Định dạng đoạn văn bản
	Cách 2: Sử dụng thanh công cụ Formatting
	Bullets and Numbering
	Slide 23
	Số đầu dòng: 
	Slide 25
	Tab
	C2: Đặt dấu Tab có kèm thêm kí hiệu phía trước
	Định dạng Khung, Nền
	Định dạng nền
	Slide 30
	Slide 31

